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Chapter 1

Overview of BPM Portal

This guide is intended for administrators, who, through BPM portal, can interact with BPM 
applications.

Introduction to BPM Portal     2
BPM Portal is a Web-based user interface. Administrators can interact with BPM applications 
through BPM Portal.

Logging in to BPM Portal     2
Log in as administrators. 

BPM Portal Keyboard Shortcuts     3
BPM Portal provides a list of keyboard shortcuts to access various menus and menu options.
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Introduction to BPM Portal 

BPM Portal is a Web-based user interface through which you can interact with BPM applications.

When you log in to BPM Portal, BPM Portal displays the Home tab for all users. Task performers 
can display and modify tasks assigned to them, and manage their preferences. 

The Management tab lets managers query, report on, and control processes and resources.

The Administration tab is for administrators to modify configuration parameters controlling BPM 
operations, manage components, and install or uninstall applications. 

Note   Because all QAD BPM features required by normal users are available in .NET UI, QAD 
does not recommend that normal users use BPM Portal.

Fig. 1.1
BPM Portal

Logging in to BPM Portal

To access BPM Portal as an administrator:

1 Start the Login page.

2 Log in as an administrator.

Username. Enter the username. The default value is admin.

Password. Enter the password. The default value is admin.

QAD Domain. Choose an option from the drop-down list. If omitted, it defaults to the QAD 
(system) domain. The value only matters when accessing group (role) memberships in User 
Management of the portal, so you can typically ignore it.
               Questions? Visit community.qad.com

https://community.qad.com
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Fig. 1.2
Logging in to BPM Portal

BPM Portal Keyboard Shortcuts

BPM Portal provides the following keyboard shortcuts to access various menus and menu options.

Table 1.1  
BPM Portal Keyboard Shortcuts

Tab Keys Menu or Menu Option

Home Ctrl+Shift+T My Tasks

Ctrl+Shift+M My Instances

Ctrl+Shift+S Applications

Ctrl+Shift+D Dashboard

Ctrl+Shift+O Profile

Ctrl+Shift+F Preferences|Filters

Management CTRL+SHIFT+I Overview|Instances

CTRL+SHIFT+A Overview|Applications

CTRL+SHIFT+R Reports|My Resports 

CTRL+SHIFT+N Instance Manager|Instances

CTRL+SHIFT+K Instance Manager|Tasks

CTRL+SHIFT+W Instance Manager|Worksteps

CTRL+SHIFT+C Balanced Scorecard|Console

Administration CTRL+SHIFT+V System|Log Viewer

CTRL+SHIFT+U User Management|Groups

CTRL+SHIFT+G User Management|Groups

CTRL+SHIFT+Q User Management|Queues

CTRL+SHIFT+P User Management|Permissions

CTRL+SHIFT+E User Management|Delegate Settings

CTRL+SHIFT+L Applications|BP Server

CTRL+SHIFT+Z Applications|BPM Web Flow
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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               Questions? Visit community.qad.com

https://community.qad.com


Chapter 2

Using QAD BPM Portal 

Working with My Instances on the Home Tab     7
You can use Home|My Instances to view, check status of, and remove system background 
processes.

Searching for Process Instances on the Management Tab     11
You can use Management|Overview|Instances to search for all process instances.

Working with My Reports on the Management Tab     12
You can use Management|Reports|My Reports to create your own reports containing any data from 
the BPM database, and displayed with custom layouts. 

Working with Instances on the Management Tab     30
You can use Management|Instance Manager|Instances to search for all process instances for a 
particular BP Server application label. You can also view dataslot values and remove process 
instances from this page. 

Restarting BP Server     33
You can use Administration|System|Status to stop and restart BP Server or BPM Events.

Using Configuration Interface     33
You can use the Configuration interface to change log levels for BPM components, and configure 
BP Server and the e-mail server.

Viewing Log Files on the Administration Tab     37
You can use Administration|System|Log Viewer to track the status and error messages for each 
component.

Defining Business Calendars     37
You can define business calendars using Business Calendar and assign them to specific users or 
groups.

Managing Users on the Administration Tab     40
You can use Administration|User Management|Users to search for all users and maintain user 
properties specific to BPM. Also you can use the tab to grant BPM data access permissions and 
portal usage permissions to selected QAD users. 

Managing Groups on the Administration Tab     43
You can use Administration|User Management|Groups to search for all groups and maintain group 
properties specific to BPM. Also you can use the tab to grant BPM data access permissions and 
portal usage permissions to selected QAD groups.
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Viewing and Changing Application Status     44
You can view and change the current statuses of applications that are deployed to BP Server. 
               Questions? Visit community.qad.com

https://community.qad.com
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Working with My Instances on the Home Tab

As an administrator, you can view, check status of, and remove system background processes by 
using My Instances on the Home tab.

Viewing Process Instances

To view system background process instances that you currently own, you can click Home|My 
Instances. 

The following two system background processes are available in QAD BPM. During the 
installation of QAD BPM, BPM Installer installs these two system background processes and 
creates instances for them. So on the My Instances page, you can see these two instances. 

• QDoc Event Handler

• Daily Tasks Notifications

Fig. 2.1
My Instances Page
 

You can check the process status in the following modes: 

• Tabular View

• Flow View

• Audit History

Checking Status in Tabular View

To check the status of a process in the tabular view, you can do one of the following:

• In the My Instances list page, click the PSV Tabular View icon.

Fig. 2.2
Clicking Tabular View Icon

• In the flow view of the Process Status Viewer page as shown in Figure 2.5 on page 9, click the 
Tabular View link. 

• In the Audit History page as shown in Figure 2.7 on page 10, click the Tabular View link.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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On the Tabular View page, you can see work steps in tabular format. The name of the process 
instance is displayed below the link trail. 

Fig. 2.3
Process Status View-Tabular View

The Tabular View displays the Start work step as the first work step at the top of the list. Then the 
completed work steps in order of the completion time, the activated work steps, and suspended 
work steps sorted by activation time follow successively. The End work step is displayed as the 
last work step.

The work step status is marked in the table, using color coding. Each color indicates a different 
status of the work step, as explained in the following table.

Table 2.1  
Work Step Color Coding 

Work Step Color Status

Orange Activated work step

Green Completed work step

Gray Inactive work step

Blue Skipped work step

Red Suspended work step

Dark Green Monitoring work step in wait state

Checking Status in Flow View

To check the status of a process in the flow view, you can do one of the following:

• In the My Instances List page, click the PSV Flow View icon. 

Fig. 2.4
Clicking Flow View Icon

• In the tabular view of the Process Status Viewer page as shown in Figure 2.3 on page 8, click 
the flow view link. 

• In the Audit History page as shown in Figure 2.7 on page 10, click the flow view link.

The following figure shows an example of the process flow view page. The process instance name 
is displayed below the link trail.
               Questions? Visit community.qad.com

https://community.qad.com
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Fig. 2.5
Process Status View-Flow View

Checking Status in Audit History

To check the status of a process in Audit History, you can do one of the following:

• In the My Instances List page, click the Audit History icon. 

Fig. 2.6
Clicking Audit History Icon

• In the tabular view of the Process Status Viewer page as shown in Figure 2.3 on page 8, click 
the Audit History link. 

• In the flow view of the Process Status Viewer page as shown in Figure 2.5 on page 9, click the 
Audit History link.

The following figure shows an example of the Audit History page. The process instance name is 
displayed below the link trail.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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Fig. 2.7
Audit History

You can see, in the header section, the information of the process instance, such as instance 
creator, start date and time, and elapsed time.

Note   The process instance completion date and time, along with total duration, can be displayed 
only for completed process instances. 

You can also view the following information in the details section. 

Date/Time. Displays the date and time of the activity transactions. You can sort the audit data 
by clicking the column header.

Activity (Group By). Displays the name of each task in the process.

Performer. Displays the name of the performer to whom each task is assigned.

Description. Describes the status change of the process instance or the activity transaction. 

Data Changes. Available only for completed tasks. 

Removing Process Instances

Administrators can remove system background processes from the My Instances page. Similarly, 
normal users can remove their own process instances from the My Instances page, but the portal is 
typically not exposed to normal users.

To remove instances:

1 From the My Instances page, select the instances you want to remove.

2 Click Remove.

Note   Even for managers who want to remove process instances, it is much easier to use My 
instances on the Home tab than to use Instance Manager on the Management tab.
               Questions? Visit community.qad.com

https://community.qad.com
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Searching for Process Instances on the Management Tab

You can also search for process instances from the Management tab by completing the following 
steps:

1 On the Management tab, click Overview|Instances to display the Instances overview page. 

The Instances Overview page displays information about the application instances you are 
currently using. By default, it displays all instances of the first application in the Application 
drop-down list, and the following information about each instance:

Table 2.2  
Instance Overview Information

Column Description

Application A unique identifier for the application instance.

Instance The name of the process instance.

Status The status of the filtered instance.

Creator The creator of the process instance.

Details Click the PSV Tabular View icon in this column to display the tabular view of the process 
instance. Click the PSV Flow View icon in this column to display the process instance flowchart 
at the point of the active task. Click the Audit History icon in this column to display the audit 
history of the process instance.

Priority Priority level that the user determines when initiating the process instance. It can be Low, 
Medium, High, or Critical.

Estimated Duration Estimated duration to complete the process instance, which the application developer decides.

Start Date The date the process instance was initiated.

Due Date The date by when the process instance ought to be completed that the application developer 
determines.

End Date The date on which the process instance was completed.

2 Use the search features in the filter bar to specify the process instances you want to search.

Fig. 2.8
Searching for Process Instances

• Select a BPM application from the Application drop-down list in the upper left of the filter 
bar. Then you can see data on all instances for the selected application in the workspace.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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• Select an option from the Status drop-down list. Options include: All, Active, Completed, 
Removed, and Suspended. Active indicates that the instance is active and can be run. 
Suspended indicates that the instance is temporarily stopped until the Resume option is 
selected.

• Specify a Creator if applicable. Click the Select Creator icon to open the User List, from 
which you can select a valid Application user.

• Select an option from the Start Date Range drop-down list. Options include: Today or 
Yesterday, This Week or Last Week, This Month or Last Month, and so on. To define a 
more specific time range, click the Select From Date icon, choose a start date from the 
pop-up calendars. Then click the Select To Date icon and choose an end date from the 
pop-up calendars.

• Select an option from the Priority drop-down list. Options include: All, Critical, High, 
Medium, and Low.

• Select an option from the Duration drop-down list. Options include: Hours, Weeks, Days, 
and Business Days. Use this search criterion only for instances with a Completed status.

3 After you have finished entering filter criteria, click Search to locate the specified instances.

Note   You can retrieve and check status of process instances from the Instances overview page, 
but you cannot remove instances from the page.

Working with My Reports on the Management Tab

BPM Portal allows you to define simple reports on-the-fly to retrieve process instance or task 
information with simple filtering. But those reports have the following limitations:

• Can only include process instance or task information

• Single-table report only, with no SQL joins

• No totals, counts, control breaks, or calculated fields

• Simple fixed layout

The BPM database contains detailed information on the state of all business process instances, 
their templates, and event-level details. When you use JasperReports, an open-source Java 
reporting framework, you can create detailed reports containing any data from the BPM database, 
and in custom layouts.

Note   This manual covers only a little of the JasperReports functionality. For more information, 
refer to Jasper documentation.

Installing and Configuring JasperAssistant Plug-in in Studio

You can use Jasper Assistant plug-in with OpenEdge Developer Studio to create your Jasper 
reports. 

Note   Although the JasperAssistant Eclipse plug-in is not free, you can use the stand-alone 
iReport tool from Jasper, which is free, to design the same reports. If you use iReport, the details of 
implementing reports are different from what is described here.
               Questions? Visit community.qad.com

https://community.qad.com
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Complete the following steps to install JasperAssistant:

1 Launch OpenEdge Developer Studio.

2 Click Help and select Install New Software.

Fig. 2.9
Installing New Software

3 Click the Add button to display the Add Repository window. 

In the Name box, enter the Jasper Assistant update site.

In the Location box, enter http://www.jasperassistant.com/updates/3.x/.

Click OK.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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Fig. 2.10
Entering Data in Add Repository

4 Check the Jasper Assistant line item.

5 Click Next, accept the license, and Click Finish.

6 Restart OpenEdge Developer Studio.
               Questions? Visit community.qad.com

https://community.qad.com
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After installing the Jasper Assistant plug-in, configure the preferences and data source:

1 From the Window menu, select Preferences|JasperAssistant|Data Sources.

Fig. 2.11
Selecting Data Sources

2 Click New and select Database Data Source in the Data Source Type drop-down list.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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Fig. 2.12
Selecting Database Data Source

3 Click OK to display the New Database Data Source window. Enter data in the text boxes. 
Make sure that you fill the corresponding text boxes with the following data.

• Driver: com.ddtek.jdbc.openedge.OpenEdgeDriver

• URL: jdbc:datadirect:openedge://hostname:DB_SQL_port; DatabaseName=BPM_DB_ 
name

• Username-Password: BPM database DBA credentials set during BPM installation

• JAR file 1: DLC_Home/java/openedge.jar
               Questions? Visit community.qad.com

https://community.qad.com
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Fig. 2.13
Creating a Database Data Source

4 Click Test and confirm that the connection is successful.

5 From the Window menu, select Open Perspective|Other|JasperAssistant to switch Studio to 
JasperAssistant perspective.

Note   This step is optional. It is for your convenience.

6 From the File menu, select New|Project to create a Java project to develop reports. Select Java 
Project wizard from the New Project dialog window and click Next. Then enter information in 
the New Java Project dialog window. The following figure shows an example of it.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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Fig. 2.14
Creating Jasper Reports Project

Creating and Opening Reports 

To create reports using New Report Wizard:

1 From the File menu, select New|Other.

2 In the New wizard, select JasperAssistant|Report.
               Questions? Visit community.qad.com

https://community.qad.com
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3 In the New Report Wizard dialog window, select the parent project folder and then enter the 
report name in the File Name text box and click Next.

Fig. 2.15
Creating a New Report

4 Select a BPM database as the data source and click Next.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm
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Fig. 2.16
Selecting a Data Source 

5 Skip the SQL entry for now and click Finish.

Note   JasperReports allows creating reports from templates, but this guide does not cover that 
feature.

6 Double-click the report source file (with .jrxml extension) to open the existing report.

Fig. 2.17
Opening Existing Report

Designing Jasper Reports

Report Layout

Reports are structured visually as horizontal bands containing data in a fixed vertical stack. 
Designers can decide the content and visual layout of each band with a specific level of details. All 
bands are optional and designers can have their discretionary choices according to the target 
report. 
               Questions? Visit community.qad.com

https://community.qad.com
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Here is a list of the bands typically used for most reports, in the order they are stacked vertically in 
the report layout. 

• Title: Appears once at the beginning of the report. 

• Page Header: Appears at the beginning of each page.

• Column Header: Appears at the beginning of each column, for multi-column reports.

• Group Header: Printed above the detail section each time the associated group’s grouping 
expression changes in value. If multiple groups are defined, their headers appear in the order 
in which the groups are defined.

• Detail: Printed for each line of data retrieved from the report’s data source.

• Group Footer: Printed below the detail section just before the associated group’s grouping 
expression changes in value. If multiple groups are defined, their footers appear in the order in 
which the groups are defined. Always printed after the last detail line.

• Column Footer: Appears at the bottom of each column, for multi-column reports.

• Page Footer: Appears at the bottom of each page.

• Last Page Footer: Replaces the regular page footer on the last page of the report.

• Summary: Appears once at the end of the report.

The following figure shows an example of the report layout.

Fig. 2.18
Report Layout

Expression Syntax

Expressions are critical in JasperReports, as they are used to calculate variables as well as define 
how to categorize and partition the reported data by group. Expression syntax is based on standard 
Java, enhanced with Jasper-specific characters and functions.

Jasper-specific functions are as follows.

• $F{<field name>}: Reference a field by name.

• $V{<variable name>}: Reference a variable by name.

• $P{<parameter name>}: Reference a parameter by name; not supported with BPM.

• $P!{<parameter name>}: Reference a parameter by name within an SQL query string only; 
not supported with BPM.
Comments? Go to goo.gl/MfwKHm

https://goo.gl/MfwKHm


22     QAD Business Process Management Administration Guide

 

• $R{<resource key name>}: Reference a string literal by key name within the resource bundle 
associated with the report; useful for language translation.

Example   

• new Integer(Math.max($V{Price1}, $V{Price2}))

• (new SimpleDateFormat(“dd/MM/yyyy”)).format($F{OrderDate})

• $F{SpecialOffer}.booleanValue()? $F{SpecialPrice}: $F{Price}

What Are Fields, Variables, and Parameters?

The data elements making up the contents of a report are fields, variables, or parameters, in 
addition to literal text and graphical elements.

• Fields: Data elements retrieved directly from the data source, typically from database tables.

• Variables: Values calculated using expressions and built-in calculation functions, typically 
based on the fields retrieved from the data source or parameter values.

Variables have the following properties that specify how they are calculated.

• Calculation: Can be Count, Distinct Count, Sum, Average, Lowest, Highest, Standard 
Deviation, Variance, First, System, or Nothing.

• Expression: Specifies a calculation formula referencing fields, parameters, and other 
variables as appropriate.

• Reset Group and Type: If Reset Type is Group, then Reset Group references the group 
whose breaks specify when the variable’s value is reset.

• Value Type: Java class defining the data type (Example: java.lang.Integer, java.lang.
String, java.lang.Long)

• Parameters: Values that the requester of the report specifies at run time, just before the report is 
generated. However, the BPM-JasperReports integration does not support parameters, so they 
are not covered further in this document.

What Are Groups?

A group specifies how designers ought to group or partition the detailed report contents based on 
common values. It is the same as what is called Control Break in many other report writers. The 
most typical use case is the grouping of data based on the values of some non-key fields in the 
database. A report can and typically does include multiple groups, used to provide several levels of 
detail with counts or other calculated summaries for each group.

Example   If you want to group process instances on the report by their process creator within the 
application name, define both Application Name and Process Creator as groups.

To define a group, use a grouping expression based on fields retrieved from the data source using 
the same syntax described in “Expression Syntax” on page 21. Typically, it is a field or variable 
name that is used to partition the report details into useful sections.

Example   To group the BPM process instances by the Application Name field called 
APP_NAME, the grouping expression is $F{APP_NAME}.
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Defining BPM Database Query and Fields

The first step in designing a report is typically defining an SQL query that retrieves the data 
displayed on the report or used in its calculations.

• Analyze the BPM database schema using an SQL-based query tool (Example: DbVisualizer or 
SQuirrel SQL) to find the location of the required data and relevant keys.

• Write the SELECT statement, including JOIN, WHERE, and ORDER BY clauses.

To specify the query:

1 Open the report and go to the Outline view in Studio.

2 Select the top-level report node.

3 In the Properties view, select the drill-down button for the Query property.

4 Enter the SQL statement into the dialog box and Click OK.

Fig. 2.19
Specifying the Query

To specify the database fields retrieved from the query in the report:

1 Open the report and go to the Outline view in Studio.

2 Select the top-level report node.

3 Right-click to the Field Wizard, and select the data source.

4 Alter the SQL query, if necessary.

5 Select the desired fields using the dialog box and Click Finish.
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Fig. 2.20
Selecting the Fields

Defining Groups and Variables

Besides the fields making up most of the detailed line items of the report, you are also required to 
define variables and groups. Variables include all counts, totals, and other statistics calculated at 
the group or report level, in addition to calculated fields. Typically you define the variables and 
groups together, because many variables are designed to summarize data at the group level for 
display in group headers or footers.

To define a group:

1 Open the report and go to the Outline view in OpenEdge Developer Studio.

2 Expand the top-level report node and select the Groups node.
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Fig. 2.21
Selecting the Groups Node

3 Right-click to the Add Group command.

4 Fill in the Name, Expression, and other properties in the Properties view.

Fig. 2.22
Filling in Properties 

To define each variable:

1 Open the report and go to the Outline view in Studio.

2 Expand the top-level report node and select the Variables node.

3 Right-click to the Add Variable command.

4 Fill in the Name, Expression, Initial Value Expression, and Value Type in the Properties view.

5 Select the Reset Type and, if relevant, the Reset Group value to associate the variable with a 
group level.
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Laying Out Reports and Preview

To lay out a report:

1 Design each band that is to appear on the report, including headers, footers, and details.

2 Drag desired report display objects from the Palette into the desired bands.

Fig. 2.23
Dragging Report Display Objects from the Palette

• Use text fields for most data elements, with Expression property referencing fields or 
variables and any calculations.

• Set Evaluation Group and Evaluation Time properties to correct values reflecting timing 
of calculations.

• Use text fields with literal values to define field labels.

Note   Arrangement of data elements and literals within each band is entirely flexible and user-
defined.

3 Design and refine layout details.

Note   Use frames to define areas with special colors or other attributes to contain related 
fields with the same display characteristics.
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Fig. 2.24
Using the Frame

To preview the report:

1 Select Preview tab.

2 Select data source, normally BPM database.

3 Fix errors and rework implementation as required.

Deploying Reports

When a report is correct and complete, make sure that you deploy it manually to the BPM server 
and portal.

Note   JasperReports libraries used at report generation time are standard with BPM.

1 Decide whether the report is common or application-specific. 

Common reports can access all BPM data, but application reports retrieve only data for a 
single BPM application.

2 To deploy your JasperReports as a Common Report in BPM, copy your report source file (*.
jrxml) to DLC_HOME/oebpm/jboss/webapps/deploy/sbm.
war/ebmsapps/common/reports/. 
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To deploy your JasperReports as an application-specific report in BPM, copy your report 
source file (*.jrxml) to DLC_HOME/oebpm/jboss/webapps/deploy/sbm.
war/ebmsapps/<application name>/reports/.

Note   Create the reports/ directory within the application directory if not already present. 

3 Copy all images, icons, and other graphical files used on the report to 
DLC_HOME/oebpm/jboss/webapps/deploy/sbm.war/WEB-INF/classes/

4 Add DLC_HOME/oebpm/jboss/webapps/deploy/sbm.war/WEB-INF/classes/ to the 
BPM portal classpath.

Note   Make sure that you take this step, so that JasperReports can retrieve the resource files 
placed in this location at run time. 

5 Ensure that all users who are to run the report have correct permissions specified in BPM 
Portal. Take the following steps:

a Log in as an administrator user.

b Go to the Administration|User Management|Users page.

c Enter the ID of the user who is to run reports into the User Name field and Click Search.

d Select the user ID displayed in the user line to display the user page.

e Enter the administrator password in the Admin Password field.

f Go to the Permissions tab and check the Default Report permission box.

g Go to the Business Process Portal Configuration tab, and select the Report check box, and 
click Save.

6 Configure settings for temporary file cleanup in the bpmportal.conf file.
bpmportal.jasper.schedule.cleanup.start
bpmportal.jasper.schedule.cleanup.interval
bpmportal.jasper.schedule.cleanup.startdelay
bpmportal.jasper.schedule.cleanup.cutoff
bpmportal.jasper.schedule.cleanup.timeout
bpmportal.jasper.schedule.cleanup.maxfilesize

Running Reports

After you deploy the report, you can run it from and display it in BPM Portal. Complete the 
following steps:

1 Log in to BPM Portal.

2 Go to the Management|Reports|My Reports page.

3 Select a desired report and view format, defaulting to HTML.
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Fig. 2.25
Running the Report

4 Click View to display the report.

Fig. 2.26
Viewing the Report Page 1
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Fig. 2.27
Viewing the Report Page 2

Working with Instances on the Management Tab

On the Management tab, Instance Manager|Instances also enables you to search for and view a list 
of process instances, and change process instance properties for the selected application.

Searching for Process Instances

From the Instances page, you can search for all process instances for a particular BP Server 
application label. But you cannot search for instances for more than one application at a time, 
because this page does not provide any other filter criteria except Application. 

To search process instances under a particular BP Server application:

1 On the Management tab, click Instance Manager|Instances to display the Search Instances 
page. 

2 Select an application from the Application drop-down list at the top of the Search Instances 
page. To further define your search on a specific attribute, select the Attributes option, and 
click Search.
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3 Click the Search Criteria tab, and enter relevant data in the Instance Name, Creator, Priority, 
Start Date, and Due Date boxes.

a In the Instance Name box, enter the name of the Instance that you want to retrieve. 

The search engine is case-sensitive. By default, an asterisk (*) is entered for you to view 
all instances. 

b In the Creator box, enter the name of the Creator that you want to retrieve in the text box. 
Or, click the Select Creator icon to open the Search Users page.

The search engine is case-sensitive. By default, an asterisk (*) is entered for you to view 
all creators. 

c In the Priority box, select an option from the drop-down list. 

The option “All” is selected by default.

d In the Start Date and Due Date boxes, specify a time period from the options in the 
corresponding drop-down list. Or, click the Select Date icon to set the respective start date 
or due date. 

By default, all dates are specified.

4 Click the Display Attributes tab and you can see a list of dataslots. Select the check boxes for 
the dataslots that you want to change.

Note   Dataslots of type Document, Object, and XML are not displayed in the Display 
Attributes tab.

5 Click the Search button at the bottom of the page to retrieve all instances that meet the search 
criteria you have specified.

The search results are presented in the Instance List page as shown in the following figure.
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Fig. 2.28
Instance List Page
 

You can see two frames on this page. The top frame displays all instances you have selected in step 
3 and dataslots you have selected in step 4. The bottom frame allows you to apply common values 
to selected dataslots. As seen in the top frame, instances are presented in a tabular format, with 
each row representing an instance. Instance name and dataslots are displayed in columns.

If you select no attributes in step 4, you cannot see any dataslots on the Instance List page. It 
displays only the Remove, Remove All, and Cancel options.

Viewing Dataslot Values

After you get the search results of specific process instances, you can view the values of selected 
dataslots. You can view them directly from the dataslot columns in the top frame. Or you can click 
the link in the Instance column to display the selected dataslots in the bottom frame. To view all 
the dataslots of a specific instance, make sure that you have selected all the dataslot types on the 
Display Attributes tab. 

Removing Process Instances

After you get the search results of specific process instances, you can remove the instances by first 
selecting them and then clicking Remove.

Note   This method is the best way to remove process instances whose owner is not the current 
user.
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Restarting BP Server

You can stop or restart BPM servers from the Administration tab. Click Administration to open the 
System Status page and you can see server statuses, as shown in the following figure.

Fig. 2.29
System Status Page

• To stop BP Server or BPM Events if it is running or suspended, select the corresponding check 
box and then click Stop.

• To restart BP Server or BPM Events if it is not running, select the check box for it and then 
click Start. BPM Portal starts the selected servers and updates the System Status page.

Note   Restart BP Server whenever a managed adapter is modified or removed, or a configuration 
setting is changed. This is a quick way for you to see the configuration changes; for example, 
changes to log levels. However, it is not a full restart. If you do not see your changes, or encounter 
any error or inconsistent behavior, use stopbpm.sh and startbpm.sh in the 
QAD_BPM_HOME/scripts directory to do a full restart of BPM. 

Using Configuration Interface 

You can use the Configuration interface to do following:

• Changing log levels for BPM components

• Configuring BP Server

• Configuring the e-mail server

Changing Log Levels 

To change log levels for BPM components, follow these steps:

1 On the Administration tab, click System|Configuration|Log to display the Log Configuration 
page.

2 Scroll through the listed parameters and modify values as required. 

3 Click Save.

Note   It is useful to set BP Server Log Level to debug.
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Fig. 2.30
Setting BP Server Log Level to Debug

Configuring BP Server

You can configure the BP Server in either of the following ways:

• By using the configuration interface in BPM Portal

• By modifying the oebps.conf file

To configure BP Server using the configuration interface, follow these steps:

1 On the Administration tab, click System|Configuration|BP Server to display the BP Server 
Configuration page.

2 Scroll through the listed parameters and modify them as you want.

Note   It is useful to enable BP Server Debug Flag for printing the jst.writeLog in scripts. 

Fig. 2.31
Enabling BP Server Debug Flag for Printing the jst.writeLog in Scripts

Enabling Email Notifications and Email Reader

In developing a process, the process developer can define an e-mail notification workstep; for 
example, in the approval subprocess, one step is to configure an e-mail notification to a list of 
stakeholders. 
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Fig. 2.32
Notify Stakeholders Workstep

For the process developer to define an e-mail notification workstep, the prerequisites are that the 
following settings are enabled here on the BP Server Configuration page:

• Sending Email notifications for task assignment or available task

• Start Email Reader

Fig. 2.33
Enabling Email Notifications and Email Reader

Note   This e-mail notification is different from the Tasks Notification described in “Setting up 
Tasks Notification Email” on page 71. The Tasks Notification described in “Setting up Tasks 
Notification Email” is intended to give a summary of BPM tasks to the end users. It does not rely 
on the two settings here.

To configure BP Server by modifying the oebps.conf file, open the file in the 
DLC_HOME/oebpm/server/conf folder and edit it. The oebps.conf file includes all the 
configuration parameters for BP Server, some of which are not displayed in the configuration 
interface in BPM Portal. 

To enable Email Reader in the bpserver.conf file, set the property bpserver.email.
reader.start to True. In this way, when the portal server starts, the Email Reader starts 
automatically.

If you want to start or stop Email Reader immediately, regardless of whether bpserver.email.
reader.start is True, you can use the startBPServerAdmin.sh tool.

• To stop the Email Reader:

cd $DLC_HOME/oebpm/server/bin
./startBPServerAdmin.sh
connect admin admin
stopEmaillistener 
disconnect
exit
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• To start the Email Reader:

cd $DLC_HOME/oebpm/server/bin
./startBPServerAdmin.sh
connect admin admin
startEmailListener
disconnect
exit

Configuring Email Server 

To configure the e-mail server using the configuration interface, follow these steps:

1 On the Administration tab, click System|Configuration|Email to display the e-mail server 
configuration page.

2 Scroll through the listed parameters and set the parameters. 

Note   If you want users to get notification e-mail, make sure that you specify the BP Server 
Email ID. 

Fig. 2.34
Setting BP Server Email ID

You can also configure the e-mail server in oebpsemail.properties in the 
DLC_HOME/oebpm/server/conf directory. The following table presents the configuration 
parameters for the email server.

Table 2.3  
Email Server Configuration Parameters

Parameter Name Description

bpserver.email.incoming.
server

Name of the e-mail server where the mailbox of bpserver.email.id is 
located (for example,mail.qad.com). It is normally different from the 
outgoing mail server.

bpserver.email.incoming.
server.protocol

Protocol used to receive the mails from the e-mail server. Its values could be 
IMAP|IMAPS|POP3|POP3S. This property is optional and if not specified, 
default value is IMAP.

bpserver.email.incoming.
server.port

The default value for this port for protocols: [IMAP-143,IMAPS-
993,POP3-110,POP3S-995]

bpserver.email.id E-mail address for BP Server to send notification e-mail to users 

bpserver.email.incoming.
server.user

User name to access the mailbox of bpserver.email.id on the e-mail 
server.
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Viewing Log Files on the Administration Tab

With Log Viewer, you can view log files for the following components:

• Business Process Portal

• OEBPS

• BPM Web Flow

• BP Server

• BPM Events

• BPM Process Store

• Archiver

• Event Publisher

Note   You can adjust the log level for these and other categories on the Log Configuration page. 
See “Changing Log Levels” on page 33.

To view log files in the Log Viewer, follow these steps:

1 On the Administration tab, click System|Log Viewer.

2 To view log files for a specific component, select an option from the Log File drop-down list. 
To specify the number of lines that each page contains, enter a number in the Number of Lines 
box. 

3 Click Go. 

Note   Typically, you view log files after work steps are suspended to troubleshoot issues.

Note   The BP Server log is the most useful log.

Defining Business Calendars

Administrators can define business calendars using Business Calendar and assign them to specific 
users or groups.

bpserver.email.incoming.
server.password

Password used to access the mailbox of bpserver.email.id on the e-
mail server. The password is not clear text; encrypt the password by using 
the utility encrypt.sh in the DLC_HOME/oebpm/server/bin 
directory.

bpserver.email.backup.
folder

The backup folder on the e-mail server. It is optional.

bpserver.email.subject.
pattern

A prefix to the subject line in the email. In this way, the e-mail subject is 
more meaningful. 

bpserver.email.preferred.
template.type

Email template type can be either plain text (etl) or HTML (htl). The default 
is etl. 

bpserver.email.check.
interval

The frequency of e-mail checking. The default interval is 60,000 
milliseconds (60 seconds). 

Parameter Name Description
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To define a business calendar, complete the following steps:

1 On the Administration tab, click System|Calendars to display the Calendar list page, which 
lists all the information about each of the existing business calendars.

2 Click Add Calendar in the Calendar list page.

The Add Calendar page, which contains General, Working Time, and Non-working Time 
sections, is displayed, enabling you to enter the new business calendar information. An 
example of this page is shown in the following figure.

Fig. 2.35
Add Calendar Page

3 In the General section, enter relevant data, according to the following explanations:

a Specify a name and description for the business calendar in the Name and Description 
boxes.

Note   You cannot use the following special characters in the name or description while 
defining a calendar: < >‘%;+ \|“

b From the Time Zone drop-down list, select the geographical time zone for the business 
calendar.

c Define the Year Range for the business calendar by selecting the start and end years from 
the From and To drop-down lists.

d Define the Regular Business Hours by specifying the start and end times using the Start 
Time and End Time drop-down lists.

e Define the Mid-Day Break by specifying the start and end times using the Start Time and 
End Time drop-down lists.

Note   Name, Description, and Time Zone are the required fields.

4 Open the Working Time section to define Working Time.

You can define working time if you want to specify business hours different than the regular 
business hours defined in the General section.
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5 Open the Non-working Time section to define non-working time.

If you want to specify a holiday or weekend, you can define it in the Non-working Time 
section.

6 Click Save and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.To cancel the action 
and exit the current page, click Cancel.

Setting or Unsetting a Default Calendar

Once you have defined a business calendar or different business calendars, you can specify a 
particular business calendar as the default calendar. BPM uses the default calendar for due date 
calculations when no business calendar is assigned to the user or the group. 

To set a default calendar:

1 On the Administration tab, click System|Calendars to display the Calendar list page.

2 Click the option in the Default Selection column for the calendar that you want to set as a 
default calendar. 

Fig. 2.36
Setting a Default Calendar

3 Click Save. 

Note   Notification e-mail service requires a calendar of each subscriber. The lack of either a 
default calendar or an assigned calendar leads to errors. 

Once you select a default calendar, if needed, you can deselect it so that you have no default 
calendar.

To unset a default calendar:

1 On the Administration tab, click System|Calendars to display the Calendar list page.

2 Click the No Calendar option in the Default Selection column. 

3 Click Save.
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Managing Users on the Administration Tab

You can search for all users and maintain user properties specific to BPM from Users on the 
administration tab. Also you can use the tab to grant BPM data access permissions and portal 
usage permissions to selected QAD users. 

Searching for Users

To search for users:

1 Click Administration|User Management|Users to display the Users list page. 

By default, the Users list page does not display any users. See Figure 2.37.

Fig. 2.37
Users List Page
 

2 To display the list of users, do one of the following:

• To view the list of all users, click All in the Quick Search. 

• To display specified users, 

• Specify the user name in the User Name box, and click Search.

• You can also search by first name, last name, group, or the initial letter of user names. 

Fig. 2.38
Searching for Users

3 You can view the details and group memberships of a specific user.

• To view the user details, click the user name hyperlink in the User Name column to display the 
User Detail page. 
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• To view the group memberships of the user, click the View hyperlink in the Group 
Memberships column. You can see a list of QAD groups in which the user is a member with 
respect to the login domain on the Memberships Details page. The group displayed is the 
group defined in QAD Enterprise Applications SE and the role defined in QAD Enterprise 
Applications EE.

Note   This screen is one of the only BPM portal screens that currently use the logged-in QAD 
domain value.

Note   Searching for all groups is required when you load user data to OpenEdge Developer 
Studio. 

Maintaining User Properties Specific to BPM

You can use the User Details page to maintain user properties specific to BPM. 

Note   Properties maintained in QAD EA are read-only in the User Details page. 

To update BPM user information:

1 Enter the administrator password in the Admin Password text box. 

Note   If you want to change the administrator password, go to Home|Profile.

2 In the User Details section, enter or modify the relevant data as necessary. 

Note   You can select a business calendar for the user here.

Fig. 2.39
Maintaining User Properties
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3 Click Save to save the changes.

Click Reset to reset the form and remove the information you just entered.

Click Cancel to cancel the action and exit the current page.

Managing User Permissions

As an administrator, you can grant or revoke permissions to specific BPM data to selected QAD 
users.

To manage permissions for a user:

1 In the Users list page, click the user name hyperlink in the User Name column for the users 
you want to update.

2 Click Permissions to go to the Permissions section.

3 Select a component in the Component drop-down list, which includes BP Server, BPM 
Events, Management, Administration, and dashboard.

4 Select or clear the check box to grant or revoke permission for the selected component.

Fig. 2.40
Maintaining User Permissions

5 Click Save to save the changes.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.
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Managing Groups on the Administration Tab

You can search for all groups and maintain group properties specific to BPM from Groups on the 
administration tab. Also you can use the tab to grant BPM data access permissions and portal 
usage permissions to selected QAD groups. 

Note   The group displayed is the group defined in QAD Enterprise Applications SE and the role 
defined in QAD Enterprise Applications EE.

Searching for Groups

Searching for a group is similar to searching for a user. To search for a group, complete the 
following steps:

1 On the Administration tab, click User Management|Groups to display the Groups list page.

By default, it does not display any groups. 

2 To display the list of groups, do one of the following:

• Click All in the Quick Search bar to view the list of all groups.

• Specify the group name by entering it in the Group Name box, or search by the initial letter of 
the group names, and then click Search to display the specified group.

3 You can view the details, members, and group memberships of a specific group.

• To view the group details, click the group name hyperlink in the Group Name column to 
display the Group Details page.

• To view the members of the group, click the icon in the Member column. 

• To view the group memberships of the user, click the View hyperlink in the Group 
Memberships column. You can see a list of QAD groups of which the current group is a 
member with respect to the login domain.

Note   This screen is one of the only BPM portal screens that currently use the logged-in QAD 
domain value.

Note   In order to load user data into Studio, searching for all groups is a required installation or 
setup step.

Maintaining Group Properties Specific to BPM

You can use the Group Details page to maintain user properties specific to BPM. 

Note   Properties maintained in QAD EA are read-only in the Group Details page. 

To update group information:

1 In the Group Details section, enter or modify the relevant data as necessary.

Note   The group name contains only alphanumeric characters and underscores (_), and it 
starts with an alphabetical character.

Note   Administrators can select business calendars in this page.

2 Click Save to save the changes.

To reset the form and remove the information you just entered, click Reset.
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To cancel the action and exit the current page, click Cancel.

Managing Group Permissions

As an administrator, you can grant or revoke permissions to specific BPM data to selected QAD 
groups.

To manage permissions for a group:

1 In the Groups list page, click the group name hyperlink in the Group Name column for the 
group you want to update.

2 Click Permissions to go to the Permissions section.

3 Select a component in the Component drop-down list, which includes BP Server, BPM 
Events, Management, Administration, and dashboard.

4 Select or clear the check box to grant or revoke permission for the selected component.

5 Click Save to save the changes.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.

Viewing and Changing Application Status

As an administrator, you can view and change the current statuses of applications that are deployed 
to BP Server. 

Viewing Application Status

Go to Administration|Applications|BP Server to view application status.

There are four options of application status. 

• Ready to Install: applications that you can install but have not installed on BP Server

• Installed: applications that are currently installed on BP Server

• Suspended: applications that are currently suspended on BP Server

• Deprecated: applications that are deprecated on BP Server

You can select one of these options to view the corresponding application list. By default, the 
system displays Installed applications.
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Fig. 2.41
Viewing Applications

Installing Applications

To install applications that are ready for installation, follow these steps:

1 Select the Ready to Install option to display applications that you can install but have not 
installed.

2 From the list, select the applications that you want to install on BP Server and click Install.

3 In the pop-up Application install status page, click OK. 

Then in the BP Server Installed Application page, you can see the newly installed applications.

Uninstalling Applications

To uninstall applications that are currently installed or deprecated on BP Server, follow these 
steps:

Note   Before uninstalling, remove or complete all the process instances.

1 Select the Installed or Deprecated option to display applications that are currently installed or 
deprecated. 

2 From the list, select the applications that you want to uninstall and click Uninstall.

3 Click Yes when you are prompted for confirmation. You can optionally select Force Uninstall 
to let the system remove active process instances before it removes the applications. 
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Fig. 2.42
Viewing Applications

4 In the pop-up Application uninstall status page, click OK.

Then in the BP Server Ready to Install page, you can see the uninstalled applications.

Suspending Applications

To suspend applications that are currently installed on BP Server, follow these steps:

1 Select the Installed option to display applications that are currently installed.

2 From the list, select the applications that you want to suspend on BP Server and click Suspend.

3 In the pop-up Application suspend status page, click OK. 

Then in the BP Server Suspended Application page, you can see the suspended applications.

Resuming Applications

To resume applications that are currently suspended or deprecated on BP Server, follow these 
steps: 

1 Select the Suspended or Deprecated option to display applications that are currently suspended 
or deprecated.

2 From the list, select the applications that you want to resume on BP Server and click Resume.

In the pop-up Application resume status page, click OK. 
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Overview of BPM Packaging and Deployment

Sometimes you are required to promote business processes from one environment to another 
environment. A common scenario is that after the installation of QAD BPM, the business analyst 
evaluates the sample processes and asks to customize the processes or develop new processes. 
When the process development is finished, you are prompted to promote the modified or new 
business processes to the target environment. 

Fig. 3.1
Development Cycle for QAD BPM Processes

To do this task, you first create a BPM package, which includes all the artifacts required to execute 
the business processes successfully on the source environment. Then you transfer the BPM 
package to the target environment. You can choose to install the package to the BPM repository, to 
deploy the package to the BPM server, or to both install and deploy the package on the target 
environment. You can also load the package into the OpenEdge Developer Studio on the target 
environment for further development.

QAD BPM provides you with the BPM Packaging and Deployment Utility to create, install, and 
deploy BPM packages during BPM process packaging and deployment. After the installation of 
QAD BPM, the utility is available as the script bpm_package.[sh|cmd]in the 
QAD_BPM_HOME/scripts/ directory. Its general syntax and usage are as follows:

bpm_package.sh ACTION [OPTIONS]

The usage details are introduced in the later sections.
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The following figure describes the BPM package flow in OpenEdge Developer Studio and BPM 
servers.

Fig. 3.2
BPM Package Flow

1 When the process development is finished, use BPM Meta Utility to create the studio package.

2 Transfer the studio package to the BPM repository on the BPM server.

3 Use BPM Packaging and Deployment Utility to create the BPM package.

4 Transfer the generated BPM package to the target environment. 

5 Choose either of the following two options:

• Use BPM Meta Utility to load the BPM package to OpenEdge Developer Studio to start 
customization. 

• Use BPM Packaging and Deployment Utility to install and deploy the BPM package to 
make it ready for launch. 

More details are discussed in the following sections. 
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BPM Repository

QAD BPM provides a file system-based repository mechanism. The repository root directory is 
QAD_BPM_HOME/repository. The repository includes the following BPM process-related 
artifacts:

• Adapters: Java-based code that business process worksteps use to communicate with external 
parties such as QXtend

• Business objects: Java-based code that business processes use to store business data

• Dataslots

• Messages

• Projects

• BizLogic (BPM) projects: OpenEdge Developer Studio projects used for business process 
development. A BPM project can contain multiple business processes.

• Rules projects: OpenEdge Developer Studio projects used for business rules development.

• Common Resources projects: OpenEdge Developer Studio projects used for Business 
Object and Adapter development.

During the installation of QAD BPM, the following artifacts are installed to the corresponding 
directories in the repository:

• Base adapters are installed to the QAD_BPM_HOME/repository/Adapter directory.

• Base business objects are installed to the QAD_BPM_HOME/repository/Business Object 
directory.

• Base dataslots are installed to the QAD_BPM_HOME/repository/Dataslot directory.

• Messages for infrastructure processes TasksNotification and QdocEventHandler are installed 
to the QAD_BPM_HOME/repository/Message directory.

• Base projects are installed to the QAD_BPM_HOME/repository/Project directory.

Sample business processes listed in the following are bundled with QAD BPM (2.1) as packages. 
But they are only copied to the repository—not installed or deployed after the installation of QAD 
BPM. You can find them in the QAD_BPM_Home/repository/bpm_package directory. 

• Customer Creation

• Item Creation

• Sales Order Credit Review 

• Supplier Creation

• Inspection (EOB)

• Receiving (EOB)

• Supplier Performance (EOB)

• Supplier Return (EOB)

Note   The EOB sample processes were introduced for QAD Enterprise Edition only, not yet for 
QAD Standard Edition. 

During BPM process packaging and deployment, this repository mechanism provides functions to 
import and export BPM artifacts.
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Fig. 3.3
BPM Repository Structure
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Installing and Deploying Sample Process for Evaluation

To evaluate a sample process, you are first required to have it installed and deployed to BPM 
server. You can use the utility bpm_package.sh to install and deploy the package for the process. 

1 Run the following command line:

QAD_BPM_Home/scripts/bpm_package.sh -import -package BPM_Package_Zip

Note   For more information on installing and deploying the BPM package, see “Installing and 
Deploying BPM Package” on page 66.

2 Enter the admin passwords for BPM and Corticon when prompted. 

Example: Installing and Deploying Process Item Creation

You want to install and deploy the Item Creation process for QAD EE for evaluation. Take the 
following steps:

1 Run the following command line:

QAD_BPM_Home/scripts/bpm_package.sh -import -package 
QAD_BPM_Home/repository/bpm_package/ItemCreation_EE.zip

2 Enter the admin passwords for BPM and Corticon when prompted. 

Then the package ItemCreation_EE.zip is deployed and ready for launch and evaluation.

Developing Business Processes

After evaluation, you can start developing business processes. The following figure gives a high-
level guideline for developers to develop BPM process in OpenEdge Developer Studio.
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Fig. 3.4
BPM Process Development

1 Import necessary BPM packages to OpenEdge Developer Studio with BPM Meta Utility.

2 Develop the processes. 

3 Publish the processes to the development BPM server.

4 Test the processes on the development BPM server. 

• If the processes do not meet the requirements, go back to step 2. 

• If the processes meet the requirements, go to step 5. 

5 Create a studio package to export the BPM process-related projects and metadata from 
OpenEdge Developer Studio and transfer it to the BPM server.

6 Create the BPM package.

7 Transfer the generated BPM package to the testing or deployment environment, and install and 
deploy it to the BPM server. 
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To provide support for business process development, you are required to import the BPM 
package QAD_Base, which provides BPM foundation and process templates, into the studio. 
Additionally, if you want to develop the process by customizing the sample process bundled with 
QAD BPM, you are also required to import the corresponding BPM package into the studio. 

QAD BPM provides you with the BPM Meta Utility to execute with OpenEdge Developer Studio 
to import and export metadata and projects to and from the studio. After the installation of QAD 
BPM, this utility is available in the QAD_BPM_Home/scripts/bpm_meta_utility.zip 
directory. Therefore, in developing business processes, the first step you are required to take is to 
bring BPM Meta Utility to OpenEdge Developer Studio.

Bringing BPM Meta Utility to OpenEdge Developer Studio

To bring BPM Meta Utility to OpenEdge Developer Studio, take the following steps:

1 Start OpenEdge Developer Studio with a new workspace.

2 Transfer bpm_meta_utility.zip from QAD_BPM_Home/scripts on the BPM server to 
any other directory.

3 Extract bpm_meta_utility.zip to your OpenEdge Developer Studio workspace.

4 Import the bpm_meta_utility project into your studio workspace.

a From the File menu, click Import.

Fig. 3.5
Importing bpm_meta_utility to Workspace

b In the pop-up dialog, enter existing and select Existing Projects into Workspace before 
you click Next. 
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Fig. 3.6
Selecting Import Source

c Click Browse or enter your workspace path directly, and then click Finish.

Fig. 3.7
Selecting Import Source

5 Display the Console view.
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BPM Meta Utility outputs some logs to the console. To review the log messages, you are 
required to enable the Console view of the studio. 

a From the Window menu, select Show View|Other.

b Enter console to filter the result, and then select Console before you click OK.

Then you can see the Console tab appear, and BPM Meta Utility is ready for use. 

Fig. 3.8
Console Window

Importing BPM Support Artifacts into OpenEdge Developer Studio

To provide support for business process development, take the following steps to import the BPM 
package QAD_Base into the studio.

1 Transfer QAD_Base.zip from QAD_BPM_Home/repository/bpm_package on the BPM 
server to any other directory.

2 Use BPM Meta Utility to import QAD_Base.

a In the OpenEdge Developer Studio, select the bpm_meta_utility project, and select 
Import BPM Metadata from the drop-down menu of the green button with a white arrow 
and a brown bag.

Fig. 3.9
Importing BPM Metadata
               Questions? Visit community.qad.com

https://community.qad.com


Developing, Packaging, and Deploying BPM Processes      57

 

Note   Make sure that you take this step. Otherwise, you get an error as shown in the following 
figure. 

Fig. 3.10
Launching Import BPM Metadata Error

b In the pop-up dialog, enter the full path name of QAD_Base.zip.

Fig. 3.11
Entering Full Path of QAD_Base.zip

3 Import the following projects included in QAD_Base to your workspace in the same way as 
importing bpm_meta_utility described in earlier steps.

• bpm_adapter

• bpm_base

• bpm_bo

• ProcessUtilities
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Fig. 3.12
Importing Projects

Then in the Project Explorer panel, you can view the projects that are imported to the studio. Now 
everything is ready for you to start the process development.
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Fig. 3.13
Projects Imported to Studio
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Importing Sample Process Packages for Customization

For process development, you can choose to customize the sample processes. BPM sample process 
packages are in the QAD_BPM_Home/repository/bpm_package directory. To import these 
sample process packages into OpenEdge Developer Studio, refer to “Importing BPM Support 
Artifacts into OpenEdge Developer Studio” on page 56.

The following figure shows the result after you import the sample process ItemCreation_EE to 
OpenEdge Developer Studio. And you can use the standard OpenEdge Developer Studio functions 
to customize the process.

Fig. 3.14
Projects Imported to Studio

After the development of the processes is finished, publish the processes to the BPM Server and do 
your testing.

Creating BPM Package

When you consider the processes to be ready after the iteration of developing, publishing, and 
testing, you want to make them available to another environment. You can create a BPM package 
for installation and deployment. 
               Questions? Visit community.qad.com

https://community.qad.com


Developing, Packaging, and Deploying BPM Processes      61

 

A BPM package contains everything that is required to execute the business processes 
successfully. Which specific artifacts are included in the package is defined in an XML file called 
BPM package descriptor. Because of the complexity of BPM Package, you can have a descriptor 
template first generated from OpenEdge Developer Studio and then customize the template. 

Generating BPM Package Descriptor Template

To generate a BPM package descriptor template, take the following steps:

1 In OpenEdge Developer Studio, select the bpm_meta_utility project, and select Generate 
BPM Package Descriptor from the drop-down menu of the green button with a white arrow 
and a brown bag.

Fig. 3.15
Generating BPM Package Descriptor

2 In the pop-up dialog, enter the full path where you want to save the descriptor template and 
click OK.

Fig. 3.16
Entering Package Descriptor Full Path

3 Enter the application name for which you want to create the package and click OK. 

Fig. 3.17
Entering Application Name

Then you can see the descriptor template that is generated in the path you have specified. 
<?xml version="1.0" encoding="UTF-8"?>
<QAD>

<!-- Replace the token @xxx@ (including "@") with real values -->
<!-- QAD Version -->
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<QADVersion>@QADEE@</QADVersion>
<!-- Application Name as the default package name -->
<Application>@APPLICATION_NAME@</Application>

<!-- Application Description -->
<Description>@APPLICATION_DESCRIPTION@</Description>
<BPM>

<Projects>
<!-- BPM Project -->
<Project type="BizLogic" name="@BIZLOGIC_PROJECT_NAME@">

<Processes>
<!-- Each process is a BPM Process -->
<!-- Operations: 
Reinstall: Install a new application, or reinstall the existing 
application, or install a new version of the current application. 
Note!If you specify Reinstall, the system removes existing instances.
RefreshPt: Reload the process template of the application. 
InstallAsVersion: Publish a versioned process template.
If you do not specify the value, the system uses InstallAsVersion.-->
<Process templateName="@TEMPLATE_NAME@" applicationName=
"@TEMPLATE_APPLICATION_NAME@"/>
<Process templateName="@TEMPLATE_NAME@" applicationName=
"@TEMPLATE_APPLICATION_NAME@" operation="Reinstall"/>
<Process templateName="@TEMPLATE_NAME@" applicationName=
"@TEMPLATE_APPLICATION_NAME@" operation="RefreshPt"/>
<Process templateName="@TEMPLATE_NAME@" applicationName=
"@TEMPLATE_APPLICATION_NAME@" operation="InstallAsVersion"/>

</Processes>
</Project>
<!-- Corticon Project -->
<Project type="CorticonRules" name="@CORTICON_RULES_PROJECT_NAME@">

<RuleFlow name="@RULE_FLOW_NAME@" serviceName="@DECISION_SERVICE_NAME@" 
minorVersion="0" majorVersion="1"/>
<RuleFlow name="@RULE_FLOW_NAME@" serviceName="@DECISION_SERVICE_NAME@" 
minorVersion="3" majorVersion="2"/>

</Project>
<!-- Business Object Project -->
<Project type="CommonResources" name="@BO_PROJECT_NAME@">

<BusinessObjects>
<!-- Examples: category name: qadbpm category package: com.qad.bpm.bo -->
<Category name="@BO_CATEGORY_NAME@" package="@PACKAGE_NAME@">

<BusinessObject name="@BO_NAME@"/>
<BusinessObject name="@BO_NAME@"/>

</Category>
<Category name="@BO_CATEGORY_NAME@" package="@PACKAGE_NAME@">

<BusinessObject name="@BO_NAME@"/>
<BusinessObject name="@BO_NAME@"/>

</Category>
</BusinessObjects>

</Project>
<!-- Adapter Project -->
<Project type="CommonResources" name="@ADAPTER_PROJECT_NAME@">

<Adapters>
<Category name="@ADAPTER_CATEGORY@">
<Adapter name="@ADAPTER_NAME@" class="@FULL_ADAPTER_CLASS_NAME@"/>
<Adapter name="@ADAPTER_NAME@" class="@FULL_ADAPTER_CLASS_NAME@"/>

</Category>
<Category name="@ADAPTER_CATEGORY@">

<Adapter name="@ADAPTER_NAME@" class="@FULL_ADAPTER_CLASS_NAME@"/>
<Adapter name="@ADAPTER_NAME@" class="@FULL_ADAPTER_CLASS_NAME@"/>

</Category>
</Adapters>

</Project>
<!-- Other Common Resources Project -->
<Project type="CommonResources" name="@RESOURCE_PROJECT_NAME@">

<!-- Special directories: $BPM_APP_DIR$: $OEBPS_HOME/server/ebmsapps 
$BPM_WEB_DIR$: $OEBPS_HOME/jboss/deploy/sbm.war $BPM_DIR$: 
$SBM_HOME/server Types: file or dir -->
<Resources>

<Resource type="file" path="$BPM_APP_DIR$/@PATH@"/>
<Resource type="dir" path="$BPM_WEB_DIR$/@PATH@"/>
<Resource type="file" path="$BPM_DIR$/@PATH@"/>
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</Resources>
</Project>

</Projects>
<!-- Message -->
<Messages>

<Message name="@MESSAGE_NAME@"/>
<Message name="@MESSAGE_NAME@"/>

</Messages>
</BPM>

</QAD>

Customizing BPM Package Descriptor Template

You can use your favorite XML editor to modify the descriptor template, replace the tokens with 
real values, and delete tags that you do not need. You can get the real values for the tokens in your 
workspace.

• QADEE: The QAD version that this package applies to. Available values are QADEE, QADSE, 
or ALL.

• APPLICATION_NAME: Meaningful application name for the whole package.

• APPLICATION_DESCRIPTION: Description for the package.

• BIZLOGIC_PROJECT_NAME:The corresponding BizLogic (BPM) project name in OpenEdge 
Developer Studio.

• CORTICON_RULES_NAME: The corresponding Corticon rules project name in OpenEdge 
Developer Studio.

• RESOURCE_PROJECT_NAME: The corresponding common resources project name in 
OpenEdge Developer Studio.

• TEMPLATE_Name: The base name of the .spt file for the process template.

• TEMPLATE_APPLCATION_NAME: The application name specified for the business process 
template when the template is created.

• RULE_FLOW_NAME: The base name of the .erf file in a Corticon Rules project.

• DECISION_SERVICE_NAME: The decision service name used in the Corticon adapter to 
deploy and execute the rules. This attribute is optional. If not specified, the rule flow name is 
used. 

• MAJOR_VERSION: The major version of the rule flow. You can open the rule flow file to get 
the value for it.

• MINOR_VERSION: The minor version of the rule flow. You can open the rule flow file to get 
the value for it.

• BO_CATEGORY_NAME: The category name for the business object when it is created. From the 
OpenEdge menu, select Tools|Business Objects to view the category name for the business 
object. 

• PACKAGE_NAME: The full package name for the category when it is created. You can also get 
the name by generating the java class in a Common Resource project. 

• BO_NAME: The name for the business object when it is created.

• ADAPTER_CATEGORY: The category name for the adapter. From the OpenEdge menu, select 
Tools|Managed Adapters to find the category for the adapter.

• ADAPTER_NAME: The adapter name, which you can view from OpenEdge|Tools|Adapters.
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• FULL_ADAPTER_CLASS_NAME: The full class name for the adapter. In the process template, 
select the adapter and then click Advanced Properties to view the full class name for it. 

• PATH: The file path relative to the prefix.

• MESSAGE_NAME: The message name, which you can view from OpenEdge|Tools|Messages.

Here is an example of the BPM package descriptor for the Item Creation process for QAD EE. 
<?xml version="1.0" encoding="UTF-8"?>
<QAD>

<QADVersion>QADEE</QADVersion>

<Application>ItemCreation_EE</Application>

<Description>Item Creation Processes for EE</Description>

<BPM>
<Projects>

<Project type="BizLogic" name="ItemCreation_EE">
<Processes>

<Process templateName="ItemCreation_EE" applicationName=
"ItemCreation_EE"/>
<Process templateName="ItemCostApproval_EE" applicationName=
"ItemCostApproval_EE"/>
<Process templateName="ItemDefinition_EE" applicationName=
"ItemDefinition_EE"/>
<Process templateName="ItemProcessSelect_EE" applicationName=
"ItemProcessSelect_EE"/>
<Process templateName="ItemRepetitiveSetup_EE" applicationName=
"ItemRepetitiveSetup_EE"/><Process templateName="ItemCostSetup_EE" 
applicationName="ItemCostSetup_EE"/>
<Process templateName="ItemCustomerInfoSetup_EE" applicationName=
"ItemCustomerInfoSetup_EE"/>
<Process templateName="ItemDiscreteSetup_EE" applicationName=
"ItemDiscreteSetup_EE"/>
<Process templateName="ItemEngineeringSetup_EE" applicationName=
"ItemEngineeringSetup_EE"/>
<Process templateName="ItemKanbanSetup_EE" applicationName=
"ItemKanbanSetup_EE"/>
<Process templateName="ItemManufacturingSetup_EE" applicationName=
"ItemManufacturingSetup_EE"/>
<Process templateName="ItemPriceListApproval_EE" applicationName=
"ItemPriceListApproval_EE"/>
<Process templateName="ItemSupplierInfoSetup_EE" applicationName=
"ItemSupplierInfoSetup_EE"/>

</Processes>
</Project>

<Project type="CorticonRules" name="ItemCreateRules_EE">
<RuleFlow name="ItemProcessSelection_EE" minorVersion="0" majorVersion=
"1"/>

</Project>

<Project type="CommonResources" name="BusinessObjects_EE">
<BusinessObjects>

<Category name="qadbpm" package="com.qad.bpm.bo">
<BusinessObject name="EngChangeItemDetail_EE_2"/>
<BusinessObject name="ItemReplacement_EE_2"/>
<BusinessObject name="Item_EE_2"/>
<BusinessObject name="KanbanItemActive_EE_2"/>
<BusinessObject name="RepetProductionSched_EE_2"/>
</Category>

</BusinessObjects>
</Project>

<Project type="CommonResources" name="QdocAdapters_EE">
<Adapters>

<Category name="QdocAdapters">
<Adapter name="MaintainItemDataAdapter" class=
"com.qad.bpm.adapters.qdocadapters_ee.MaintainItemDataAdapter"/>
</Category>
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</Adapters>
</Project>

</Projects>

</BPM>

</QAD>

Exporting BPM Process Related Projects and Metadata

To export the BPM process-related projects and metadata from OpenEdge Developer Studio, you 
can use BPM Meta Utility to create a studio package. The studio package is a zip file that is 
created from OpenEdge Developer Studio and includes all the projects and metadata that are 
defined in the package descriptor. 

To create the studio package, follow these steps:

1 In the OpenEdge Developer Studio, select the bpm_meta_utility project and then select 
Export BPM Metadata from the drop-down menu of the green button with a white arrow and a 
brown bag.

Fig. 3.18
Exporting BPM Metadata

2 In the pop-up dialog, enter the full path name of the customized descriptor and click OK.

BPM Meta Utility creates the studio package according to the definition in the descriptor and saves 
it in your studio workspace directory. If something is wrong, you can find the error on the Console 
tab.

Then, you are required to transfer the resulting studio package from your studio workspace 
directory to QAD_BPM_Home/repository/studio_package and the BPM package descriptor 
to a directory on the BPM server; for example, /qadapps/bpm. After that, everything is ready for 
you to create the BPM package.

Generating BPM Package 

Use the following command to create the BPM package:
QAD_BPM_HOME/scripts/bpm_package.sh -export [-descriptor DESCRIPTOR_FILE] [-output-dir 
OUTPUT_DIRECTORY]
Comments? Go to goo.gl/MfwKHm
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The following table shows the use of parameters for creating the package.

Table 3.1  
bpm_package.sh Parameters for Creating the Package

Parameter Use

-descriptor DESCRIPTOR_FILE Specify the full path name of the package descriptor

-output-dir Output_Directory Specify the directory for the output of the resulting package file. If 
you do not specify the directory, you can find the resulting package in 
current studio workspace directory.

Example   
/qadapps/bpm/scripts/bpm_package.sh -export -descriptor /qadapps/bpm/ItemCreation_EE.xml -
output-dir /qadapps/bpm

In this example, BPM Packaging and Deployment Utility packages the artifacts according to the 
definition in the package descriptor /qadapps/bpm/ItemCreation_EE.xml. You can find the 
resulting package ItemCreation_EE.zip in /qadapps/bpm.

BPM Packaging and Deployment Utility installs the studio package created in the earlier step to 
the repository and then creates the BPM package. The name of the resulting package file is 
Application_Name.zip. The application name in the file name is the one that you specify 
when you generate the package descriptor template. 

You can find the BPM artifacts in the following corresponding folders of the .zip file. 

• Adapters:

• Qdoc adapter: /bpm/meta/adapter/QdocAdapters/Adapter

• Corticon adapter: /bpm/meta/adapter/CorticonAdapters/Adapter

• Business object: bpm/meta/bo/Business Object.xml

• Dataslot: /bpm/meta/dataslot/dataslots.xml

• Message: /bpm/meta/messaging/messages/Message.xml

• Project: /bpm/project/Project.zip

If you fail in creating the BPM package, you can view the logs and error messages, correct the 
errors, and go through the steps again. 

Installing and Deploying BPM Package

After the package is created, you can transfer it to the target environment. For example, you can 
transfer it to a testing environment, or you can transfer it to a production environment for release. 

Then you can choose to install the package to the BPM repository, or deploy the package to the 
BPM server, or both install and deploy the package. 

• Install: Import everything in the package to the BPM repository to make it available for 
customization.

• Deploy: Deploy everything in the package to the BPM server to make it ready for launch. 

To install the package, run the following command line on the target BPM server:
QAD_BPM_HOME/scripts/bpm_package.sh -import install -package BPM_Package_Zip

To deploy the package, run the following command line on the target BPM server:
QAD_BPM_HOME/scripts/bpm_package.sh -import deploy -package BPM_Package_Zip
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To install and deploy the package, run the following command line on the target BPM host:
QAD_BPM_HOME/scripts/bpm_package.sh -import -package BPM_Package_Zip

Table 3.2  
bpm_package.sh Parameters for Installing and Deploying the Package

Parameter Use

-package BPM_Package_Zip Specify the full path of the BPM package which you want to install or 
deploy

The installation process only checks the availability of the top-level business object. If child 
business objects are not specified in the descriptor, the installation process does not check them. 
So make sure to manually check the availability of child business objects and include them in the 
descriptor. For example, the business object SaleOrderDetails_EE_1 is a child business object for 
SalesOrder_EE_1 in the Sales Order process; in this case, make sure to include the business object 
SaleOrderDetails_EE_1 in the descriptor.

The system deploys the process templates according to the operation specified in the package 
descriptor. There are three operation options: 

• Reinstall: Existing process instances are removed, and the process template is updated.

• RefreshPt: The template is refreshed in memory. Existing and new process instances are 
affected, and Flow View uses a new diagram.

• InstallAsVersion: If the application is the same, a new version is created, but the template 
name is different. New process instances are created based on the new version. If application 
and template name are the same, it affects neither existing instances nor new instances, but 
Flow View uses a new diagram.

For a production environment where existing process instances cannot be affected, apply 
InstallAsVersion to have a new Process Template version for the same application. The new 
Process Template version has the same application name but a different process template name.

For development environment, you can use Reinstall to clean up all existing instances.

Note   Make sure that the deploy script specifies operations for deployment. If an operation is not 
specified in the descriptor, by default, InstallAsVersion is applied.
Comments? Go to goo.gl/MfwKHm
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Chapter 4

Other Administration Tasks 

Launching Processes from Custom Forms (for Authorized Users)     70
After the application developer has defined a process in OpenEdge Developer Studio, you can add 
a menu entry for the application menu to show up in .NET UI.

Updating Properties of QAD BPM     70
You can easily search and update the properties of QAD BPM in qadbpm.properties.

Setting up Tasks Notification Email     71
You can set up the daily tasks notification email to have users receive tasks notification e-mail at 
specified notification times every working day.
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Launching Processes from Custom Forms (for 
Authorized Users)

The system allows users to create a launch screen in QAD .NET UI to launch a process from 
custom forms. The application developer first defines the process in OpenEdge Developer Studio. 
Then you, as the administrator, add a menu entry to the plugin-menu.xml file to let the 
application show up in .NET UI. 

1 Open the plugin-menu.xml file under the 
Tomcat/webapps/qadhome/configurations/<SysEnvName>/menus directory.

2 In the plugin-menu.xml file, add a ShellMenuItem entry; specify the menu label in the 
label field and the process name in the value field.

Example   The administrator adds the following code to the plugin-menu.xml file. The menu 
name is Launch Process and the process name is Test Process.

<ShellMenuItem image="browse" key="test" label="Launch Process"> 
   <Command type="QAD.Plugin.Bpm.Command.LaunchProcessCommand,QAD.Plugin.Bpm"> 
      <Parameter type="System.String,mscorlib" name="processTemplateName" value="Test 
Process"/> 
   </Command> 
</ShellMenuItem>

3 Place the modified plugin-menu.xml file under 
Tomcat/webapps/qadhome/configurations/<SysEnvName>/menus, where 
<SysEnvName> is the environment name for the QAD .NET UI login; for example, qadui.

After these actions, users can see the Launch Process menu in QAD .NET UI and use it to launch 
the customized process. 

Note   Only authorized users can see the Launch Process menu and use it. You can define the 
authorization by configuring the Security settings in the plugin-menu.xml file. 

• If the security for the Launch Process menu entry is set to bpmadmin, then only the 
administrator can see and use the Launch Process menu.

• If the Security setting is blank, then the menu is not restricted to any user.

Updating Properties of QAD BPM

As a BPM administrator, you can update QAD BPM properties in qadbpm.properties in the 
oebpm/server/ebmsapps directory.

This properties file includes settings for QDoc Web Server, QXtend, Corticon rules, version of 
QAD EA, and environment name. The content of the file is shown in the following. 

qxtend.qxi.qdoc.web.service.url=
http://@INBOUND_TOMCAT_HOST@:@INBOUND_TOMCAT_PORT@/@INBOUND_WEBAPP_NAME@/services/Qdoc
WebService
qxtend.qxi.config.web.service.url=
http://@INBOUND_TOMCAT_HOST@:@INBOUND_TOMCAT_PORT@/@INBOUND_WEBAPP_NAME@/services/Qxte
ndConfigService
qxtend.qxi.soap.header=true
qxtend.qxi.erp.receiver=@INBOUND_RECEIVER@
qxtend.qxi.qxo.receiver=@INBOUND_QXO_RECEIVER@
qxtend.qxi.encoded.passwords=@INBOUND_ENCODED_PASSWORDS@
qxtend.qxi.authenticate.qdoc.version=ERP3_1
qxtend.qxi.authentication.api.program=mfasai.p
qxtend.qxi.authentication.encode.password.out=true
qxtend.qxi.validate.license.qdoc.version=ERP3_1
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qxtend.qxi.validate.license.api.program=mflvai.p
qxtend.qxo.sourceApplication=@OUTBOUND_SOURCE_APPLICATION@
corticon.decision.service.url=
http://@CORTICON_TOMCAT_HOST@:@CORTICON_TOMCAT_PORT@/@CORTICON_WEBAPP_NAME@/services/C
orticon
mfg.version=@MFG_VERSION@
qad.environment.name=@QAD_ENVIRONMENT_NAME@

The following table presents the property parameters with their descriptions.

Table 4.1  
Parameters for QAD BPM Properties

Parameter Name Description

qxtend.qxi.qdoc.web.service.url QXtend Webservice URL to process QDocs

qxtend.qxi.config.web.service.url QXtend Webservice URL to do configuration

qxtend.qxi.soap.header Whether to include SOAP headers in QDocs

qxtend.qxi.erp.receiver QXtend Inbound receiver to process QDocs

qxtend.qxi.qxo.receiver QXtend Outbound receiver to process queries

qxtend.qxi.encoded.passwords Whether password is encoded in session context of request 
QDocs. This value is the same as the value of the parameter 
encodedPasswords defined in 
<Tomcat>/webapps/<QXtend Inbound>/WEB-
INF/conf/qxtendconfig.xml

qxtend.qxi.authenticate.qdoc.
version

QDoc version of Authentication QDoc

qxtend.qxi.authentication.api.
program

Program for Authentication QDoc

qxtend.qxi.authentication.encode.
password.out

Whether password is encoded in Authentication QDoc. The 
default value is True.

qxtend.qxi.validate.license.qdoc.
version

QDoc version of Active Maintenance License Validation QDoc

qxtend.qxi.validate.license.api.
program

Program for Active Maintenance License Validation QDoc

qxtend.qxo.sourceApplication Source Application associated with BPM

corticon.decision.service.url Corticon Server URL

mfg.version Version of the associated QAD Enterprise Applications

qad.environment.name Environment name of the associated QAD Enterprise 
Applications, used in tasks notification email

Setting up Tasks Notification Email 

You can set up Tasks Notification Email to let users receive e-mail notifying them that they have 
BPM tasks to do at specified times every working day.

The tasks notification e-mail gives a summary of BPM tasks for the user. It lists by domain the 
tasks that have been assigned to the user within the last 24 hours. By clicking the link in the e-mail, 
the user can go straight to My Tasks Browse in QAD BPM to view task details and perform the 
tasks. 
Comments? Go to goo.gl/MfwKHm
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The e-mail also, in both the title and the body, displays the name of the environment where the task 
notification is created. In this way, when using multiple environments, the user can identify the 
source environment of the tasks. The environment name is specified in the QAD ERP panel during 
the installation of QAD BPM.

Fig. 4.1
Tasks Notification Email

To enable specified users to receive tasks notification e-mail, follow these steps:

1 Make sure that you have set the sender of tasks notification e-mail. The system uses the first 
valid e-mail address of the following three configuration properties as the sender in the 
following order:

• oebps.admin.email.id in the oebps.conf file in the 
DLC_HOME/oebpm/server/conf directory. It is set during the installation of OpenEdge 
BPM.

• bpserver.email.id in the oebpsemail.properties file in the 
DLC_HOME/oebpm/server/conf directory. You can edit it by going directly to 
Administration|System|Configuration|Email to set the BP Server Email ID field.
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• bpserver.sysadmin.email.id in the oebpsemail.properties file in the 
DLC_HOME/oebpm/server/conf directory. You can edit it by going directly to 
Administration|System|Configuration|Email to set the System Admin Email ID field. 

Note   Make sure that the e-mail address that you configure is valid. A valid e-mail address 
contains “@” and “.” For example, admin@abc.com is a valid e-mail address, but 
admin@localhost is invalid. If the three e-mail addresses that you configure are all invalid, 
the system cannot send the tasks notification e-mail. 

2 Go to Administration|Applications|BP Server to verify that the Daily Task Notification 
process is installed to BP Server. If it is suspended, resume it.

3 Go to Administration|User Management|Users to maintain the subscribership of users.

a Specify the user to whom you want to have tasks notification e-mail sent and click Search 
to display the User Details page.

b Select the Subscribe to Tasks Notification Email check box.

c Select a calendar from the drop-down list of the Default Calendar field. 

Note   Make sure that you have defined business calender in Administration|System|Calendars 
beforehand. The selected calendar guarantees that the e-mail is sent on working days to 
subscribers.

Configuring Notification Times

By default, the tasks notification email is sent at 9:00 and 13:00 every working day. If you want to 
customize the times when the e-mail is sent, follow these steps:

1 Go to the DLC_HOME/oebpm/server/ebmsapps directory and find the configuration file 
TasksNotification.conf. 

2 Change the DailyNotificationTimes property and save the file.

Note   The notification times string is a comma-separated list of times in the HH:MM format.

Fig. 4.2
DailyNotificationTimes

3 From Home|My Instance in BPM Portal, remove the Daily Task Notification instance.

4 Go to Home|Applications, find TaskNotification in the Application Name column and click it.

5 Specify the instance name and click Create to create a notification process instance. 
Comments? Go to goo.gl/MfwKHm
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Customizing E-mail Template

You can also customize tasks notification e-mail templates according to your needs. Go to the 
DLC_HOME/oebpm/server/ebmsapps/TaskNotification/resources directory and you 
can see templates for all supported languages. For example, 
TasksNotificationEmailTemplate_en.txt is the email template in English and 
TasksNotificationEmailTemplate_fr.txt is the email template in French.

Get the particular email template to start customization. The e-mail content is in the HTML 
format. Here shows the content of the tasks notification e-mail template in English.

//Subject
Your QAD Business Process Management Task Summary ({0})
//Body Header
<html><body>
Here is a summary of your BPM tasks ({0}):<br/>
<br/>
//Body Sector
Domain: {0}<br/>
<br/>
New tasks assigned to you after {1}:<br/>
{2}
<br/>
Current tasks:<br/>
   {3} Assigned tasks<br/>
   {4} Available tasks<br/>
   {5} Delegated tasks<br/>
of these tasks {6} are overdue and {7} are critical.<br/>
{8}
<br/>
//Body Footer
<br/>
Regards,<br/>
<br/>
QAD BPM Administrator
</body></html>
//New Task Line
   {0}.{1} (Document - {2}, {3})<br/>
//Tasks Browse Link
<a href="{0}">Click here to view your tasks.</a>({1})<br/>
//No Task
   None<br/>
//No New Task
   None<br/>

Table 4.2  
Parameters in Tasks Notification E-mail Template

Parameters Descriptions

Subject and Header {0} QAD environment name, which is from the property qad.environment.
name specified in qadbpm.properties in the 
DLC_HOME/oebpm/server/ebmsapps directory.

Body Sector {0} Domain name

{1} Time when the last notification email was sent

{2} • When there is no new task, it displays None.
• When there are new tasks, it gets the values from New Task Line. 

{3} Count of assigned tasks 

{4} Count of available tasks

{5} Count of delegated tasks

{6} Count of overdue tasks

{7} Count of critical tasks

{8} My Tasks Browse link
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New Task Line {0} Process template name

{1} Work step name

{2} Document ID1

{3} Document ID2

Tasks Browse Link {0} Tasks Browse Redirect URL, which is from the property QADSHRedirect 
specified in TasksNotification.conf in the 
DLC_HOME/oebpm/server/ebmsapps directory.

{1} Tasks Browse QADSH URI, which is from the property TasksBrowseUri 
specified in 
DLC_HOME/oebpm/server/ebmsapps/TasksNotification.
conf

Parameters Descriptions
Comments? Go to goo.gl/MfwKHm
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Product Information Resources

QAD offers a number of online resources to help you get more information about using QAD 
products.

QAD Forums (community.qad.com)
Ask questions and share information with other members of the user community, including 
QAD experts.

QAD Knowledgebase (knowledgebase.qad.com)*
Search for answers, tips, or solutions related to any QAD product or topic.

QAD Document Library (www.qad.com/documentlibrary)
Get browser-based access to user guides, release notes, training guides, and so on; use 
powerful search features to find the document you want, then read online, or download and 
print PDF.

QAD Learning Center (learning.qad.com)*
Visit QAD’s one-stop destination for all courses and training materials.

*Log-in required

https://community.qad.com
https://knowledgebase.qad.com
https://www.qad.com/documentlibrary
https://learning.qad.com
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